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Section 1. Introduction

1.1 Pharmacokinetic Analysis (PKA)

Pharmacokinetic (PK) studies provide information on the time course of drug absorption,
distribution, metabolism, and excretion (ADME). In pharmacokinetics, the relationship of
these processes to the intensity and time course of the pharmacological effects of the drug
is investigated. This process requires a reasonable knowledge of mathematics at least
through calculus.

In pharmacokinetics studies, a known dose of a drug is administered to a subject. Blood, tis-
sue, or samples of extracellular fluid (dialysates, ultrafiltrates) are removed at definite time
intervals and analyzed for the parent drug and/or its metabolites. The most common analyti-
cal technique used is liquid chromatography with UV (fluorescence or electrochemical) de-
tection.

Two alternatives to conventional discontinuous sampling of tissue or blood are in vivo mi-
crodialysis (see Figure 1.1) and in vivo ultrafiltration (see Figure 1.2). BAS provides a com-
plete line of products for Pharmacokinetic Analysis and Microdialysis, including probes, syr-
inge pumps, awake animal accessories, fraction collectors, and on-line injectors.

BAS offers two families of liquid chromatographic systems ideally suited for PKA. The BAS
200 family unifies several components in a single instrument for maximum convenience,
automation and performance. The BAS 480 family provides modular instruments for maxi-
mum flexibility. Both instrument families can work as stand-alone systems or under com-
puter control. BAS provides ChromGraph® software packages to control these instru-
ments, acquire the data, process reports, and provide specialized data treatment, such as
PKA.
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Figure 1.1. In vivo microdialysis.

Figure 1.2. In vivo ultrafiltration.
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1.2 PKA Software

PKA is a simple but multifunctional addition to the ChromGraph software package. The pur-
pose of PKA is to give a visual presentation of the whole pharmacokinetic profile. It can also
produce temporal profiles of other biological processes, such as neurotransmitter release
and basal metabolism.

PKA software runs in the Windows™ operating system. It accepts ONLY *.REP data files
generated by ChromGraph as input. PKA then generates another file, based on these data
files, that is displayed on the screen as the PK data interpretation. The program includes
functions for curve fitting, options for one- and two-compartment data modeling, graphical
plots and statistics of the analysis, and different display capabilities and printing options.
The PK profiles can be viewed for single or multiple analytes as line or bar graphs (see Fig-
ures 1.3 and 1.4).

Figure 1.3. The multiple graphs displayed in this view represent changes in four different analytes identified by a ChromGraph
report file.

Please take the time to fill out and return the registration
form in the back of this manual. Registered users will be
informed of updates to PKA software.

Fax it: 317-497-1102; or mail it: BAS – PKA Registration
2701 Kent Avenue

West Lafayette, IN 47906-1382
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Figure 1.4. A bar graph depicts the pharmacokinetic profile of a drug administered by I.P. injection.

These plots and their corresponding data files can be routed to a printer or pasted into a text
file, data processor, FAX, or other application. Another feature is the ability of the user to up-
date information. The user can define the sample time interval, dosing time, and labels for
auxiliary events or animal stimuli. The sampling interval need not be uniform. Both on-line
injection and fraction collection/autosampling can be accommodated.
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Section 2. Hardware and Software Requirements

2.1 BAS 200B and BAS 480 Series Chromatographic Systems

Both BAS 200B and BAS 480 systems can be computer-controlled using ChromGraph CON-
TROL and REPORT software. If you are using a BAS 480 system, you will need the BAS DA-
5 for data acquisition. A BAS 200B requires no external interface. ChromGraph uses an RS-
232 communication port to connect the computer to the BAS 200B or DA-5
interface.

2.2 Host Computer

ChromGraph and PKA both require a Windows 3.1 (or higher) operating system with an
Intel® (or compatible) 386SX (or higher) processor. At the time of this writing, at least a
486DX33 is highly recommended.

2.3 ChromGraph CONTROL Software

ChromGraph is a comprehensive system for chromatographic data acquisition, analysis, and
instrument control. Using CONTROL, you can collect data from up to four channels on your
LC, GC or CE system simultaneously, while using your PC for other Windows applications.
You can also collect pressure data, set solvent percentages for gradient elution (BAS 480 or
BAS 200B gradient system), and monitor the system continuously. Refer to the ChromGraph
CONTROL manual (MF-9070) for further details.
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2.4 ChromGraph REPORT Software

ChromGraph REPORT may operate independently for previously collected data, or it may be
linked to ChromGraph CONTROL for running the chromatographic system and for on-line
processing of data. REPORT provides basic data handling and processing for the BAS 200B
or BAS 480, such as detecting peaks, reporting peak parameters, and comparing data with a
standards file. Screen, Printer, or Disk can be used for report output. All output methods
containing different file formats are based on user requirements. Refer to the ChromGraph
REPORT manual (MF-9071) for further details. PKA uses the *.REP files created by
ChromGraph REPORT to plot the PK profile. A sample *.REP file format is shown below.

Figure 2.1. Sample *.REP file format.

ChromGraph Version 1.17 Mon Mar 14 23:52:48 1994

Data filename: CATS Run number: 1 Detector: A
Vial number: 0 Data Set 1 name: CATS001A
Time of run: 09:16 Date of run: 03-29-91
Method filename: CAT Run notes:
Operator: Johan Conditions:
Standards (Area): CATS Dilution multiple: 1
Time zero offset: 0 Time scale factor: 1

Peak Minutes Peak-Name pg

1 5.82 epinephrine 253.67
2 6.61 norepinephrine 253.43
3 10.72 dhba 260.56

0 Totals 767.60
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Section 3. Installation

You need to be familiar with the basics of Windows, such as mouse operations and choos-
ing commands, before you use PKA. See your Windows manual (or follow the on-line tuto-
rial from the Help Menu in the Windows Program Manager) to learn basic Windows skills.

The PKA Installation process should take less than 5 minutes. When installed, PKA will use
just 1 MB of your hard disk space.

NOTE: PKA Installer will create a directory on your hard drive called \pka. If you already
have a directory called \pka, PKA Installer will add the PKA files to that directory; therefore,
you may want to rename your directory before you install PKA to avoid confusion.

Follow these steps to install PKA onto your hard drive:

1. Insert the disk containing the PKA program into your floppy disk drive.

2. Select Run from the File Menu of Windows Program Manager. In the Command Line
text box, type “a:\instpka” (if you’ve inserted the disk into the a: drive) or “b:\instpka”
(if you’ve inserted the disk into the b: drive). Click the OK button (or press <Enter>).
OR
Double click on the “instpka” file from Windows File Manager.
OR
In Windows, start the “instpka” file from your floppy.

3. The BAS ChromGraph - PKA Installer screen (Figure 3.1) will appear. First, click the
Paths button. The Disk ID dialog box (Figure 3.2) will appear.

Figure 3.1 The ChromGraph-PKA Installer screen.
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Figure 3.2 The Disk ID dialog box.

4. Choose a Source Disk (the disk containing the PKA program) and a Destination Disk
(your hard drive). The defaults are A: and C:, respectively. If you’ve put the program
disk into your b: drive, be sure to change the Source Disk entry to B:.

5. Choose the OK button in the Disk ID dialog box. You’ll return to the PKA Installer
screen.

6. Now choose the Install button. The box along the top of the screen will show you what
PKA Installer is doing: the Current File boxes show how large (in kB) each file is,
and what percentage of it has been installed; the Total boxes show how large (in kB)
the entire program is, and what percentage of it has been installed.

7. When the program has been completely installed, choose the Exit button. You’ll notice
that a new Windows group window called “BAS” has been created (if not already pre-
sent), with the PKA program-item icon in it (Figure 3.3).

Figure 3.3 The BAS group window with PKA program-item icon.
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Section 4. PKA Software Functions

4.1 Menu Structure

PKA software uses a standard Windows pull-down menu system. (If you are not familiar
with this type of structure, see your Windows manual.) Figure 4.1 is a menu tree, showing
each selection from PKA’s main screen; the following sections describe each menu selection
in detail:

Section 4.2 ...............................File Menu .................................8
Section 4.3 ...............................Display Menu...........................14
Section 4.4 ...............................Utility Menu .............................15
Section 4.5 ...............................Curvefit Menu ..........................18
Section 4.6 ...............................Help Menu ...............................25

Several sample data files have been installed with PKA. Throughout the following sections,
you’ll find opportunities to practice procedures and familiarize yourself with PKA using these
sample files.

Figure 4.1. PKA’s menu structure.

GETTING STARTED: Double-click the PKA icon from the BAS
group window to begin the PKA program.
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4.2 File Menu

The File Menu has seven selections, which are described in the following subsections:

4.2.1 CRM → PKA
4.2.2 Load
4.2.3 PKA Parameters
4.2.4 Print Screen
4.2.5 Print Data File
4.2.6 Printer Setup
4.2.7 Exit

Section 4. PKA Software Functions
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4.2.1 File conversion, CRM → PKA

PKA uses the *.REP files created by ChromGraph REPORT to plot PK profiles. The *.REP
files are numbered by adding 3 digits (001, 002, etc.) and a letter as the last four characters
of the group name you chose in ChromGraph, and adding the REP extension. For example,
in Figure 4.2, the “ratx” group includes files ratx001a.rep through ratx010a.rep. If your
group name were only 2 letters long (e.g., “rt”), the file names would be rt001a.rep,
rt002a.rep, etc.

PKA software needs to convert the ChromGraph *.REP files to a format it can read. When
you select the CRM→PKA option, you’ll see the File Open/Print Dialog Box (see Figure
4.2). Select any file from your group of interest. PKA will search the directory for all other
files in that group (e.g., “ratx” in Figure 4.2). PKA will create a new file in that directory with
the “.PKA” extension.

Figure 4.2. File Open/Print dialog box.

For example, when you choose the file “ratx005a.rep” from the file list, PKA will find all
other data files in the “ratx” group and use them to create a single new file called “ratx.pka.”
This will be your PKA software working file.

The new file will include information you provide in the “PKA Parameters” dialog box (see
Section 4.2.3). Whenever you make changes in the PKA Parameters dialog box, you
need to repeat the file conversion.

4.2.2 Load

When you select the Load option, the File Open/Print dialog box will appear. The data file
you select will be loaded onto the screen. You can display the data as either a bar graph or
a line graph with symbols (see Section 4.4.5).
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4.2.3 PKA Parameters

Select the PKA Parameters option to add or edit information about your PK analysis.
Figure 4.3 shows the PKA Parameters dialog box, which includes the following text boxes
(described below):

PKA File Name
X - Label
Y - Label
Title
Event(s)
Peak Name(s)
Sample Time(s)
Analyst

After you’ve entered all the parameters, click the OK button. PKA will check your entries for
errors and notify you on the screen if any are found. If your inputs are not correct, the pro-
gram will not update the old parameters.

Whenever you make changes in the PKA Parameters dialog box, you need to repeat
file conversion (see Section 4.2.1). When you click on the OK button from the PKA Pa-
rameters dialog box, the program will ask you if you want to repeat file conversion. If you
have changed any values in the PKA Parameters dialog box, you should choose Yes.

Figure 4.3. PKA Parameters dialog box.
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PKA File Name: Input the directory and file name to be loaded or saved. You must use the complete
MS-DOS® path of the file: “drive:[\dir]..\filename.ext” (for example, c:\pka\ratx.pka).

X - Label, Y - Label,
Title:

The PKA program places default labels on the graph axes. If you want to change these, type
the new X - Label, Y - Label, or Title from the PKA Parameters dialog box; they will be
saved with your data file.

Event(s): This function is useful for monitoring the profile of an analyte in response to a drug dose,
behavioral stimulus, or other challenge.

For example, say you injected a dose 10 minutes after starting your data collection, and you
want to view the effect of that dosing time on your PK profile. Follow these steps to mark
any event on your plot (in this case, the time of administration of the drug on the
absolute time scale):

1. Enter the name of the event followed by a comma and a space (“Dosing Time, ”).

2. Enter the dosing time (in minutes), followed by a space (“0 ”).

3. If you want to add more events, repeat steps 1 and 2 up to a total of 10 events.
A vertical marker in the plot will indicate the name and time of each event.

(“Event1, 0 Event2, 5 Event3, 12 ... Event10, 45”).

Peak Name(s): Enter the names of one or more peaks of interest in your chromatogram. They must have the
same names as in the ChromGraph *.REP file. If you enter a name other than the name in
the *.REP file, PKA will input 0 for the amount of that analyte. For information about naming
peaks, refer to the ChromGraph REPORT manual.

Section 4. PKA Software Functions
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Sample Time: Enter the sampling time interval in minutes. On the PKA graph, this time will be the distance
between any two consecutive data points. If you choose the bar graph option (see Section
4.4.5), this will be the width of the bar.

If you enter only one sample time, the time axis will maintain the same interval between all
data points. You may enter more than one sampling time: enter each sampling interval, fol-
lowed by a comma, the number of samples collected, and a space ([time,n], [time,n], ...,
[time]).

For example, “10,1, 25,4, 10“ in the Sample Time text box will give you a plot like the
one shown in Figure 4.4. “10,1, 25,4, 10” means:

“10,1" 10-minute sample interval for 1 sample;
”25,4" 25-minute sample interval for the next 4 samples;
“10" all subsequent samples have a 10-minute interval.

If the sample times were listed instead as “10,1, 25,4" then the sample interval would re-
main as 25 minutes for all samples after sample 1.

Figure 4.4. Sample plot illustrating irregular sampling intervals.

Analyst Name: Enter a person’s name or other identification for your records (optional).
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4.2.4 Print Screen

When you select Print Screen, PKA will print the graph of the current file directly to the
printer you have selected in Printer Setup (see Section 4.2.6).

4.2.5 Print Data File

When you select Print Data File, PKA will print the current data file directly to the printer you
have selected in Printer Setup (see Section 4.2.6).

4.2.6 Printer Setup

The Printer Setup selection opens the Select Printer dialog box (see Figure 4.5). When you
select the Set Up button from this screen, a standard Windows Printer Setup dialog box will
appear, from which you can access the usual printer parameters.

Figure 4.5. Printer Setup dialog box.

4.2.7 Exit

The Exit selection terminates the PKA program. This does not close any other BAS program
running on the computer.
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4.3 Display Menu

4.3.1 Next Graph

If you have entered more than one analyte in the PKA Parameters Dialog Box (see Section
4.2.3), selecting Next Graph from the Display Menu will display the plot of the next analyte.

4.3.2 All Graphs

If you have entered more than one analyte in the PKA Parameters Dialog Box (see Section
4.2.3), selecting All Graphs from the Display Menu will display one PK profile of all the ana-
lytes. When more than one analyte is displayed, the points will be displayed as symbols
(not a bar graph). When you leave All Graphs (by choosing Next Graph or by loading a new
file), the program will “remember” and return to your previous settings.

4.3.3 Copy

The Copy option automatically copies the PK profile shown on the screen onto the standard
Windows Clipboard. You should Copy your plot often, so you do not lose any changes
when you load a different plot (see NOTE in Section 4.3.4). From the Clipboard, you can
paste the profile to a word processor or other Windows application.

4.3.4 File Name(s)

This feature lists the PKA files you have loaded (up to four). Select a file from this list to
view the plot on-screen.

NOTE: You will see the plot under the current graphic parameters. That is, any graphic pa-
rameters such as Grid or Event(s) (see Section 4.4) will be active on the plot, whether or not
they were active the last time you viewed that plot.

Section 4. PKA Software Functions
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4.4 Utility Menu

The Utility Menu contains selections that add flexibility to the display of your PKA graph.
They include:

Grid
Event(s)
Peak Name(s)
Y-Axis Type
Graph Type
Connect Points
Axes Labels

All screen tools are independent of each other. When Grid, Event(s), or Peak Name(s) is
selected, a check mark will appear next to its name in the Utility Menu. Selecting the tool
again will toggle it OFF.

Section 4. PKA Software Functions
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Figure 4.6. Screen graphics tools Grid, Event(s), and Peak Name(s) are selected in this plot.

4.4.1 Grid

When Grid is selected, a light-colored grid will appear behind your plot (see Figure 4.6). Se-
lect Grid again from the Utility Menu to turn off this option.

4.4.2 Event(s)

When the Event(s) option is selected, a vertical line will appear (see Figure 4.6) at the time
of each event that was specified in the PKA Parameters dialog box (see Section 4.2.3).
Select Event(s) again from the Utility Menu to turn off this option.

4.4.3 Peak Name(s)

When Peak Name(s) is selected, the names of all analytes will be shown in the upper right-
hand corner of the plot (see Figure 4.6). You can move the peak names along a horizontal
line by dragging them with the left mouse button. Select Peak Name(s) again from the Utility
Menu to turn off this option.

4.4.4 Y-Axis Type

You may plot your data with a linear or log scale on the Y axis. This is very helpful for curve
fitting (see Section 4.5). Since the log axis shows which data points are linear, the begin-
ning and end points for the curve fitting can be selected easily.

4.4.5 Graph Type

Data can be plotted in two ways: Choose either Bar Graph or Symbols from the cascading
menu that appears when you select Graph Type from the Utility Menu. When multiple
graphs are selected, a unique symbol will appear for each data set.

Section 4. PKA Software Functions
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4.4.6 Connect Points

When you select Connect Points from the Utility Menu, you can choose how your data is
represented: Symbols may be isolated (the “None” option), or connected by a line (“Line”).

Figure 4.7. Symbols in this graph are connected using the “Line” option.

4.4.7 Labels and Title

The PKA program places default labels on the graph axes. If you want to change these,
double-click on any label or select Axes Labels from the Utility Menu. In the Labels dialog
box (see Figure 4.8), change the labels; they will be saved with your data file.

Figure 4.8. The Labels Dialog Box.
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4.5 Curve Fit Menu

The PKA program provides several curve fitting functions:

One-Compartment Model

Two-Compartment Model

One-Compartment Model with First-Order Absorption

Once you have started any curve fitting procedure, you cannot perform any other function
until you have completed or cancelled the curve fitting.

4.5.1 Which Curve Fitting Procedure Should I Choose?

One of the purposes of PKA is to help you define a pharmacokinetic model for the system
under study. This can be partially an intuitive and partially an iterative process. There are nu-
merous books and review articles on pharmacokinetics which can be quite helpful in this
process, and we suspect that most users of this software are already familiar with them.
ChromGraph PKA is intended to be a living product. It will continue to evolve in response to
feedback from users. If you would like to see other models added, BAS will be happy to con-
sider your request.
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4.5.2 The One-Compartment Model

To use this simple exponential curve fitting technique between any two points, first select it
from the Curve Fit Menu. Then press and hold the left mouse button as close as possible to
the first point. The mouse cursor will change from an arrow to crosshairs. While holding the
left button down, move to the second point and release the mouse button. The cursor will
change back to a normal arrow and the new curve fit will appear on the screen (see Figure
4.9). The screen will also display the values for significant statistical parameters such as A
(concentration at time 0), Rate constant, Half Life, and AUC.

The curve fitting type (see Figure 4.10) is:

where A is the initial estimated analyte concentration and Ct is the analyte concentration at
time t.

The slope m and intercept b from the plot of log Ct vs. time are:

where:
⇒ m = slope
⇒ Rate constant = k = 2.3030 × slope
⇒ Half Life = 0.693 / Rate constant
⇒ N = total number of data points
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Figure 4.9. An example of simple exponential curve fitting.

Figure 4.10. The simple exponential curve fitting technique.

Time
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4.5.3 The Two-Compartment Model

The two-compartment model is mathematically the same as the one-compartment model, ex-
cept that it is second-order. This means that the plot will show a bi-exponential decay. You’ll
need to choose each of the two curves in the same way as the one-compartment method, as
follows.

Press and hold the left mouse button on the first point of the curve. The mouse will change
to crosshairs. Drag the mouse to the second point of the curve and release the button. You’ll
see a curve fit for the first portion of the plot.

Now repeat the process for the second part of the curve, choosing two points along the sec-
ond decay portion. You’ll see two curve fits for the plot (see Figure 4.11), and the screen
will display significant statistical parameters.

Figure 4.11. An example of two-compartment curve fitting.

C Ae Bet
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4.5.4 The One-Compartment Model with First-Order Absorption

The third curve-fitting method is more complex than the first two. The simple one-compart-
ment model discussed earlier relates the rate of change of the concentration of a drug to
only its concentration from one compartment to the next. When we consider that this rate of
change depends also on the drug’s absorption and elimination, we introduce first-order ab-
sorption into the model.

There are three important variables in this model: A, k1, and k2. Obviously, these three vari-
ables determine the shape of the curve. When you choose this curve-fitting method, you will
try to make the new curve fit your data by changing these three variables. When you select
this method from the Curve Fit menu, several buttons will be added to the upper left corner
of your screen:

Click on this button to end your curve fitting session. The parameter values (A, k1, and k2) and
curve will remain on the screen.

Click on this button to activate (when you want to change) the A parameter. Then use the arrow
buttons to vary the value of A, which will change by the percentage you’ve specified in “%
Change” under the Para button (see below).

Click on this button to activate (when you want to change) the k1 parameter Then use the arrow
buttons to vary the value of k1, which will change by the percentage you’ve specified in “%
Change” under the Para button (see below).

Click on this button to activate (when you want to change) the k2 parameter. Then use the arrow
buttons to vary the value of k2, which will change by the percentage you’ve specified in “%
Change” under the Para button (see below).

Use these buttons to vary the active parameter’s value up or down. The parameter will change by
the percentage you’ve specified in “% Change” under the Para button (see below).

This button opens a dialog box where you can select numerical values for A, k1, k2, T Offset, and
% Change. Set T Offset to a number that will place the beginning of the curve at an appro-
priate place on the Time axis. The % Change option varies the amount that each parameter
will change (up or down) when you click on the arrow buttons.

BONUS: You can use yet another curve fitting technique by setting k2=0. As you can see below, when k2
is set to zero in the current curve-fitting method (equation at the top of this page), the equa-
tion becomes similar to, but not the same as, the first technique, which was Ct = Ae–k1t.
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It may take some practice to become comfortable with this curve-fitting method. Take a mo-
ment now to familiarize yourself with these operations. Load the file “app.pka” (an example
file included with your software). Set Graph Type to Symbols (they’re easier to work with
than a bar graph when curve fitting). You also may want to set Connect Points to None, so
you can see the data points clearly. Now choose the third curve fitting method. The curve fit-
ting buttons will appear in the top left corner of your screen. Follow this procedure to prac-
tice curve fitting:

1. Click on the down arrow button. The default curve fit will appear (see Figure 4.12).

Figure 4.12. The initial (default) curve fit.

2. We’d like the beginning of the curve to match the beginning of significant data. Click on
the “Para” button. Set T Offset to a time when the drug begins to take effect (about
25 in this example). Leave the other parameters at default values for now. Click
“OK”; now click either arrow key. The curve shifts to the new offset position.

3. Now we need to match the curve to the data points. Click on the “A - On” button. The A
parameter is now active; click the arrow buttons until the top of the curve is about at
the height of the top data point (A should be about 40). Notice that the parameter val-
ues are in a box at the top right of the screen.

4. Click on the “On - k1” button to activate k1. Now use the down arrow key until the
curve begins to fit the data. You’ll notice that the peak of the curve fit will decrease
also; don’t worry about this for now, you’ll go back and change it later.

6. Now click “On - k2” to activate the k2 parameter, and use the arrow buttons as before.

7. Keep varying the parameters as necessary until the curve is a good fit to the data points.
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By now you’ve started to notice that it’s going to take a little “playing around” with these val-
ues to get the curve to fit your data, because this is a complex operation. Don’t forget, you
can get more precise fitting by changing the “% Change” option to a lower number. Figure
4.13 shows a satisfactory completed curve fit.

The final parameter values for the curve fit in Figure 4.13 are:

A = 40 k1 = 0.0861 k2 = 0.0163

Figure 4.13. A completed curve fit.

When you’re satisfied with your curve fit, click the “Done” button to return to normal PKA
operation. The final A, k1, and k2 values will remain in the top right corner of the screen, so
when you Copy this plot to your clipboard (and subsequently to other applications), you’ll
have a copy of the data, so that you can repeat the curve fit exactly at any time by typing the
values directly into the “Para” dialog box.

WARNING: When employing this curve fitting technique, you can use the up or down arrow buttons to change the curve.
However, when repeatedly pressing the down arrow button to decrease a parameter, you may reach a point at which the value
will no longer change. It will seem as though you are “stuck” here; that is, pressing either the up or the down arrow buttons
from this point will cause no change in the parameter value or the curve. This is due to a round-off error:

For example, if A = 1 and %Change = 1%, then when you choose the up arrow button:

So there is NO CHANGE between the original A and the new A. To remedy this situation, click on the “Para” button and change
your parameter value or increase the %Change option.
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4.6 Help Menu

The PKA program uses a standard Windows help structure. See your Windows manual for
details.
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Section 5. For Technical Support

BAS has a team of physiologists, chromatographers, software experts, and service engineers
to help you. We also have a number of academic consultants available.

In USA/Canada, call: (800) 845-4246 or (317) 463-4527

FAX: (317) 497-1102

For assistance with implanting probes and animal handling, contact:

Dr. Jim Gitzen (317-463-4527 ext. 215)
Dr. Elsa Janle (317-463-4527 ext. 225)

For assistance with chromatography problems, contact:

Dr. Chester Duda (317-463-4527 ext. 216)
or your local BAS technical representative

For assistance with software problems, contact:

Dr. Bruce Solomon (317-463-4527 ext. 226)

For assistance in Chinese or Japanese, contact:

Dr. Fuming Xie (317-463-4527 ext. 316)

In Europe, contact:

BAS Technicol Ltd.
Adcroft Street, Higher Hillgate
Stockport
Cheshire SK1 3YF, U.K.

Tel: 061-477-7020
FAX: 061-480-6090
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Fax Cover Sheet
Subject: BAS-ChromGraph-PKA Registration

To: Bioanalytical Systems, Inc.
2701 Kent Avenue
West Lafayette, IN 47906
Tel: (317) 463-4527

Fax: (317) 497-1102

Please send me future upgrade information.

From:

Name: .............................................................................. Title: ........................................................................

Institution: ....................................................................... Dept: ........................................................................

Address: ......................................................................................................................................................................

City: ................................................................................. State: ............... ZIP: .............................................

Country: ..........................................................................

Phone: ............................................................................. FAX: .........................................................................

Optional information (check all that apply):

Keep my name on mailing list.

I currently use the following BAS products:

BAS LC System
BAS PKA Products
BAS Microdialysis Products
Other __________________________________
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